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Chapter 1: About TestingPoint

About TestingPoint

Easily develop and administer tests with TestingPoint, Turning Technologies' test generation software.
TestingPoint provides an easy-to-use and time saving assessment tool. 100% native to Microsoft® Word,
teachers and administrators can now quickly author and format tests and assignments in Word using the
TestingPoint add-in.

Using the self-paced testing ResponseCard XR or XL response devices, students and meeting attendees
record their responses and submit their answers electronically to TestingPoint. Subsequently, educators and
trainers are able to grade assignments in seconds with the click of a button. This streamlined assessment
process enables teachers and trainers to apply formative assessment techniques, where they can use
student feedback, adapt the curriculum, and better meet their students' learning needs. In other words,
teachers can begin their lessons knowing which key concepts require review and clarification, and which
concepts are already well understood. This saves hundreds of hours per year in administrative and lecturing
time.

TestingPoint is available for download from the Turning Technologies Web site. The chapters of this guide
demonstrate the tools and features you need to create, administer tests and generate reports from start to
finish.

Product Introduction

TestingPoint smoothly integrates with Microsoft Word to allow a more interactive and manageable testing
environment. (Find additional information in System Requirements on page 7.) All TestingPoint options are
accessed through the TestingPoint Ribbon.

After TestingPoint is installed, the TestingPoint Ribbon appears as an active tab within the Microsoft Word
standard ribbon. This ribbon offers you all the options you need to create tests in Word, administer tests, and
generate reports. Easy-to-use features such as the Participant List Wizard, also used in TurningPoint 2008,
help you quickly get started.

Other TestingPoint features include reporting tools, the ability to use and re-use question banks, and
integration with various testing standards. You can also interact with TurningPoint 2008 to import and export
files, streamline the creation of Participant Lists, report classroom results and grades, and import
TurningPoint sessions.

Turning Technologies
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Chapter 1: About TestingPoint

System Requirements

TestingPoint is designed for use on computers with typical capabilities. You do not need the very latest
technology or a large amount of hard disk space to use TestingPoint. There are some basic requirements for
hardware and software however. These are detailed in the following sections.

Requirements for Hardware

The following hardware specifications are required before installing TestingPoint on a computer:

Intel or AMD 600 MHz class processor
256 MB RAM (256MB or more, of available RAM recommended)

60 MB hard disk space (an additional 32 MB is required if you do not have Microsoft .NET Framework 2.0
installed)

1024x768 resolution at 32-bit color or higher
Standard USB 1.1/2.0 port (for USB-based hardware devices)

Requirements for Software

The following software applications are required to take full advantage of TestingPoint capabilities:

Microsoft Windows 32 bit or 64 bit XP, Vista or 7
Windows Office XP, 2003, or 2007

Turning Technologies
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Initial Setup

There are two basic steps to consider before you begin using TestingPoint. This section describes how to:

Install TestingPoint

Open TestingPoint within Microsoft Word

Install TestingPoint

In a few simple steps, you can install TestingPoint on your computer. The installation process takes only a few
minutes, and then you will be ready to create a TestingPoint test.

Before You Begin
Check the hardware and software specifications outlined in System Requirements. A computer must meet

these requirements before installation.

To install TestingPoint software on a computer...
1 You can install TestingPoint in one of two ways:

» Download the latest version of TestingPoint from the Turning Technologies Web site. (Recommended.)

The Turning Technologies Web site is located at http://www.turningtechnologies.com. Use your web
browser to download the file to your computer. When the download is complete, double-click the setup
icon to launch the InstallShield Wizard.

* Ortoinstall from a CD, insert the CD into the computer.
After you insert the CD, the InstallShield Wizard launches automatically.

2 Click Next to continue the installation with the InstallShield Wizard.

The next page displays the license agreement. Use the scrollbar to read the license agreement on the screen,
or select the Print button to send the text to a printer.

3 Select | accept the terms in the license agreement if you accept these terms.

Accepting the terms of the license agreement permits you to continue with the process of installing
TestingPoint.

4 Click Next.

The next page displays the customer information entry fields.

5 Type your name and organization in the respective fields.

Turning Technologies
TestingPoint 1.2 8



Chapter 1: About TestingPoint

6 Click Next.
The next page confirms that the computer is ready to install TestingPoint.

7 Click Install.

The computer installs TestingPoint in the location you specify, and displays the Finish button on the page when
it completes the process.

8 Click Finish.
« Also select the Launch TestingPoint checkbox if you would like to immediately open the program.

The TestingPoint shortcut icon automatically displays on your desktop and points to the location where
you installed the program on your computer.

Open TestingPoint within Microsoft Word

TestingPoint runs within Microsoft Word. Both will open automatically (with TestingPoint appearing as an
active tab within the Word standard Ribbon) when you open TestingPoint. You will have a choice about how
TestingPoint starts up. You may determine this immediately or change it later through the Settings window.

To open TestingPoint...
1 Double-click the TestingPoint Icon on the desktop.

The TestingPoint application opens within Microsoft Word. The TestingPoint startup window displays.

2 You may choose to Create a New Test, Open an Existing Test, Import from Question Bank, or Cancel.

Choose Create a New Test to open a Microsoft Word document with a pre-inserted TestingPoint test header.
Choose Open an Existing Test to open an existing TestingPoint test document.

Choose Import from Question Bank to import test questions from a pre-existing question bank document.
Choose Cancel to close the TestingPoint startup window.

» Select the checkbox at the bottom of the Startup window to not display the Startup window when opening
TestingPoint.

If the checkbox is selected, TestingPoint startup window does not open the next time you start
TestingPoint.

To display the startup window again click Tools on the TestingPoint Ribbon and select Settings. Under
the Misc settings change Show Startup Screen to True.

Turning Technologies
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A Tour of TestingPoint

When using TestingPoint, you will need to be familiar with a few windows, interaction points, and documents
during the process of creating, saving, and administering tests. The rest of this guide will explore these in
more detail, but a few are highlighted below.

When you launch TestingPoint, Microsoft Word opens. The TurningPoint Ribbon can be accessed by
selecting the TurningPoint 2008 tab as the following image depicts.

TestingPoint Ribbon

The following descriptions define the buttons that make up the tools in the TestingPoint Ribbon.

About TestingPoint Provides the software version number and language information. It also
provides a mechanism to supply feedback on the product directly to
Turning Technologies.

Open Test Opens a previously saved TestingPoint Test.

Save as Test or Question Bank Allows you to save an active TestingPoint document as a Test or a
Question Bank.

Print Test Allows you to print and randomize the test questions.

Turning Technologies
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Insert Question

Remove Question

Insert Object

Tools

Participants

TurningTalk

TestingPoint Help
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Displays a menu of TestingPoint question types that you can insert into
a Test or Question Bank document.

Allows you to remove a question from an active Test or Question Bank
document.

Inserts an Object, such as a Test Header or Comment, into an active
TestingPoint document.

Provides advanced options to determine TestingPoint settings, import
guestions and standards, and generate reports. Also accesses the
Turning Test Administrator, which is the classroom test-taking interface.

Provides options for creating, editing, importing, and deleting
Participant Lists.

Opens the TurningTalk User Community, a social learning community
for users of Turning Technologies products and services.

Opens the TestingPoint online help file.
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TestingPoint Test Documents

TestingPoint uses Microsoft Word to generate tests. The tests can be configured to contain test instructions or
a personalized test header. To learn more about how to configure test headers or instructions, refer to
Creating a Test Document on page 19. TestingPoint generates question templates for multiple choice,
multiple response, fill in the blank, essay, short answer, numeric response, and matching question types.
When creating a test, TestingPoint will group each question added to the test based on the question type. To
learn more about test questions, refer to Types of Questions on page 16.

The Turning Test Administrator
Once the test has been distributed to the participants, run the Test Administrator from the presentation
computer to gather test results. The Test Administrator has a menu bar and three display panels:

Session Details - Displays the test name, start and end times, number of responses received and test
instructions.

Question Details- Displays the test questions, average score and possible points per question.

Participant Details- Displays the participant list selected for the current test.

Turning Technologies
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Radio Frequency ResponseCard and Receiver
During the test, students key answers into their response devices, then transmit the answers to the receiver

connected to the host computer. Both the ResponseCard XR - using radio frequency technology, and the
ResponseCard XL - using infrared technology, can be used with TestingPoint. Both devices can save answers
for an entire test session, so students only need to transmit answers once.

Radio Frequency Receiver and ResponseCard XR

Infrared Receiver and ResponseCard XL

Set Up ResponseCard® XR and XL Response Devices

Turning Technologies’ ResponseCards are compact response devices that use radio frequency or infrared
technology to send audience responses. They also allow for self-paced testing by letting students enter
responses to many different questions on the card’s multi-line LCD, then transmitting all the answers at once.

Students taking a test must use a ResponseCard to store and transmit their responses to TestingPoint. The
ResponseCards communicate with TestingPoint through the ResponseCard Receivers. The receiver is
attached to the computer running the TestingPoint software.

Turning Technologies
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Prior to administering a test, you must connect the receiver to the computer. It is recommended to check
device communication in a polling test to ensure that the device is recognized by the application.

To setup response devices...

1 Attach an IR or RF receiver to a USB port on the computer.

The receiver connects directly to the computer’s USB port. Windows detects the receiver and automatically
installs the proper device drivers.

2 Open TestingPoint.

Note Itis recommended to test all response
devices to ensure they can communicate
with the software when transmitting
responses. This should be done the first
time you connect the receiver.

Next Steps
The Device ID needs to be included in the Participant List for each participant to ensure the correct participant

receives credit for their responses. The device ID is the six-digit number on the back of the ResponseCard,
under the barcode.

Turning Technologies
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For Additional Assistance

To speak with a Turning Technologies Representative call our toll-free phone number: 1-866-746-3015. By E-
mail, send your inquiry to support@turningtechnologies.com.

Office Hours:

Monday through Friday, 7:00 AM to 9:00 PM (EST)

Mailing Address:

Turning Technologies, LLC 255 West Federal Street Youngstown, OH 44503

Assistance is also available to customers online through the Turning Technologies Web site. To access the
Web site, go to http://www.turningtechnologies.com.

Turning Technologies
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Creating and Saving Tests

The first step in using TestingPoint is to create and save a test that you will eventually print and give to the
audience. TestingPoint features eight different types of questions you can insert into tests, which allows great
flexibility in creating and administering tests.

In this chapter, you will learn about the types of test questions, how to insert questions into test documents,
how to create and save tests, and how to assign answer values.

Types of Questions

TestingPoint allows you to insert eight different types of questions into your test from a drop-down menu on
the TestingPoint Ribbon.

TestingPoint has three basic categories of questions: those that are answered with a single alpha-numeric
keypad entry, such as a number or letter; those that are answered with multiple alpha-numeric keypad entry -
which are questions with more than one answer; and those that are answered with longer alpha-numeric
entries - such as keywords.

The types of questions you can insert into your test depend on the specific response devices your audience
uses during test administration. ResponseCard XL response devices support single keypad entries only, but
ResponseCard XR response devices support single keypad entries, multiple key entries, as well as longer
alpha-numeric keyword entries.

Turning Technologies
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Single Key Entry Questions

This section describes simple alpha-numeric keypad entry questions, including:

Multiple Choice

True / False

Multiple Choice
Multiple Choice gquestions contain an area to type the question text, and allow from 2 to 10 answer choices.

True / False
True / False questions contain an area to type the question text, and an answer section with two pre-

populated answer choices (True and False).

Multiple Key Entry Questions

This section describes multiple alpha-numeric keypad entry questions, including:

Multiple Response

Matching

Multiple Response

Multiple Response questions contain an area to type the question text, and allow from 2 to 10 answer
choices. Multiple responses may be accepted for Multiple Response questions, and multiple answers may be
counted as correct.

Matching

Matching questions contain an area to type the question text, and two columns to type the answer choices, 2
to 10 answer choices are permitted in each column. You determine which answer from the right column
correctly matches the word or phrase entered in the left column.

Turning Technologies
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Keyword-Based Questions
This section describes keyword-based questions, including:

Short Answer
Numeric Response
Fill in the Blank

Essay

Note These question types are only compatible
with the ResponseCard XR. They are not
compatible with the ResponseCard XL. For
each question, participants input keyword
answers through their ResponseCard XR
response devices.

Short Answer
Short Answer questions contain an area to type the question text.

Numeric Response
Numeric Response questions contain an area to type the question text.

Fill in the Blank
Fill in the Blank questions contain an area to type the question text.

Essay
Essay questions contain an area to type the question text.

Turning Technologies
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Creating a Test Document

A TestingPoint test is created by inserting questions or objects (such as Test Headers or Comments) into a
Microsoft Word document. The following section describes how to create and save a test document.

How to Insert a Test Question
TestingPoint has eight different question types to choose from.

To insert a test question...

1 Open TestingPoint.

Microsoft Word opens and the TestingPoint Ribbon can be accessed by selecting the TestingPoint 2008 Tab.

2 Open an existing test document, or create a new test.
3 Click Insert Question on the TestingPoint Ribbon.

4 Select a question type.

For Multiple Choice, Multiple Response, and Matching questions, a dialog window displays formatting options,
such as:

the number of answer choices (2 to 10)

the number of answer columns (1 to 3)

For Multiple Response questions only, the number of responses allowed (1 to 10).

For Numeric Response questions only, the dialog window displays an acceptable value or range option. It is

possible to have both an acceptable value and to set a range.

5 Make the formatting selections and click OK.

The selected question is inserted into the document.

Note When adding more than one of the same
guestion type, they will be grouped under
their particular question type label. For
example, Multiple Choice questions will all
appear together under the Multiple Choice
label, and Matching questions will all
appear under the Matching label.

Turning Technologies
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6 Select the bracketed text placeholders in the Question and Answer sections, and type in the questions and
answers.

7 Repeat this process for as many questions as you would like to include in your test.

How to Insert a Picture Question

TestingPoint supports the inclusion of pictures or visual objects in the answer section for Multiple Choice,
Multiple Response, and Matching Questions.

To insert a picture question...
1 Click Insert Question on the TestingPointRibbon.
2 Select either a Multiple Choice, Multiple Response, or Matching question.

3 Along with any other formatting selections, select the Format to use picture or equation choices checkbox
and click OK.

The question type selected is inserted into the document and is formatted to allow a picture or visual object in
the answer areas.

4 In the Question section, type the question text.
5 In the Answer section, insert pictures or objects using Word’s Insert Tab > Picture or Clip Art.

Insert a picture for each answer space.

You can select one of the sizing or corner handles to drag and resize the picture. Find more information about
pictures in the Microsoft Word Help file.

6 Repeat this process for as many picture questions as you would like to include in the test.

Turning Technologies
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How to Remove a Question

TestingPoint questions must be deleted using the Remove Question button on the TestingPoint Ribbon.

To remove a question...
1 Select the text of the question you would like to remove.
2 Click Remove Question on the TestingPoint Ribbon.

A dialog box displays confirming your selection.

3 Click Yes to remove the question from the test.

Note Question labels cannot be deleted using
the Remove Question button. Question
labels must be “cut” from the document.
Find more information about tables in the
Microsoft Word Help file.

How to Insert a Test Header

Objects are optional fields you can insert into your test to provide structure, clarity, and additional information.
There are two kinds of objects: Test Headers and Comments.

Test Headers appear at the beginning of test documents and have editable areas for the test title and
instructions, and space for test-takers to record their name and date. By default, TestingPoint is configured to

insert a Test Header at the beginning of each test.
To insert a Test Header...
1 Click Insert Object on the TestingPointRibbon and select Test Header.

A Test Header box is inserted at the top of the open test document.

The Test Header has two active areas with bracketed placeholder text for the test title and any test instructions.

2 Select the bracketed text areas, and enter the text for the test title and instructions.

Turning Technologies
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How to Insert a Comment

Comments are text areas you can place anywhere in a test document to provide test-takers with additional

information.

To insert a Comment...

1 Place the cursor at a point in the test document where you would like to insert a Comment.
2 Click Insert Object on the TestingPoint Ribbon and select Comment.
The Comment box displays in the document where you placed your cursor.

3 Select the bracketed text area, and enter the text in the Comment box.

Turning Technologies
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Saving a Test or Question Bank

TestingPoint provides you with two options for saving a test document. The test document can be saved as a
test with a .txlt extension, or as a question bank with a .txlg extension.

Saving a test document as a question bank will allow you to easily input questions you have already created
into another test document. For more information on importing from a question bank see Import Questions
from a Question Bank on page 75.

How to Save a TestingPoint Document
After creating a test, you will need to save it as a TestingPoint test document.

To save a test document...
1 Click Save as a Test or Question Bank on the TestingPointRibbon.

A window opens which prompts you to save the document as either a Question Bank or a Test.

2 Select the radio button for Test or Question Bank, and click OK.

The Save As Test or Question Bank dialog window opens. Testing Point defaults to save Test documents in
the TestingPoint / Documents folder that was automatically created when the application was installed.

(To save the file in an alternate location on the computer, navigate to that location in the dialog window.)
3 Type afile name for the Test document in the space provided.

Keep the *.txIt extension in the filename for the document to ensure that TestingPoint will be able to open the
test file.

4 Click Save.

Turning Technologies
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How to Assign Correct Answers or Point Values

Once all the questions are inserted into your test, you can identify correct and incorrect answers, and assign
point values to questions. Test question settings are modified through the Settings window.

Note TestingPoint does not grade Short Answer
or Essay questions due to the fact that
those answers could be left open to
interpretation. You are therefore unable to
assign answer values or keywords.

To open the Settings window, select Tools > Settings from the TestingPoint Ribbon. You can also open the
Settings window by selecting the eyeglasses icon in the TestingPoint 2008 Settings Pane.

Identify a Correct Answer for Multiple Choice, Multiple Response, or
True/False Question

You can specify whether answers in your TestingPoint questions are correct or incorrect. These answers are
used to grade the tests that you administer and generate various reports about how respondents performed.
Depending on the type of question, you will have different options for setting values.

To mark an answer correct through the settings window...

1

From the TestingPoint Toolbar, select Tools > Settings.
The Settings window opens.
In the left pane of the window, identify the question for which you would like to set a correct answer.
Select the Answer you want to identify as correct.
The Answer Settings display in the right hand window.
Select Correct from the Answer Value drop-down menu.
Repeat steps 3 and 4 for each remaining Multiple Choice, Multiple Response, or True / False question.

Click Done to save your changes.

Note You can also assign a correct answer by
highlighting the answer choice, right-
clicking and selecting Correct from the
menu.

Turning Technologies
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To mark an answer correct using the Settings Pane...
1 Place your cursor on the question to which you would like to set a correct answer.

2 Select Correct from the drop-down menu on the Settings Pane next to the answer bullet that corresponds
to the correct answer.

Settings Pane - Select Correct

3 Repeat steps 1 and 2 for each remaining Multiple Choice, Multiple Response or True/False question.

Identify a Correct Answer for a Fill in the Blank Question

Fill in the Blank Questions are keyword-based questions. Essay and Short Answer are also keyword-based,
but they are not graded by TestingPoint.

To mark an answer correct for Fill in the Blank questions through the settings window...
1 From the TestingPoint Ribbon, select Tools > Settings.

The Settings window opens.

Turning Technologies
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2 Inthe left pane of window, select the Fill in the Blank question to which you would like to assign keywords.
The Question and Answer settings for that question display in the right pane of the window.

3 Under Question Settings, select Keywords.

4 Type the word(s) to include as keywords in the provided space for the fill in the blank question.

Separate multiple keywords with semi-colons. Responses containing any of the keywords will be counted as
correct.

5 In the right-hand pane, under the Answer Settings heading, select the Answer Value drop-down menu.
6 Select an answer value from the drop-down menu.

Choose Correct if you would like TestingPoint to mark answers containing any of the keywords correct.
Choose No Value if you choose not to award any value to the keywords.

You may also enter a point value for the answer. Choose Enter a point value.
7 Repeat steps 2 through 6 for each remaining keyword-based question.

8 Click Done to save the changes.

To mark an answer correct for keyword-based questions through the Settings Pane for a Fill in the Blank
Question...

1 Place your cursor on the keyword-based question for which you would like to assign keywords.
2 Type the word(s) to include in the keywords box provided on the Settings Pane

Separate multiple keywords with semi-colons. Responses containing any of the keywords will be counted as
correct.

3 Select Correct from the Answer Value drop-down

4 Repeat steps 1 - 3 for each remaining keyword-based question.
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Identify Correct Answers for Numeric Response Questions

When the Numeric Response question was inserted in the test an acceptable value or range or both were set.
To change the values follow the instructions below.

To mark an answer correct for a Numeric Response question through the settings window...

1 From the TestingPoint Ribbon, select Tools > Settings.
The Settings window opens.

2 In the left pane of window, select the Numeric question to which you would like to assign values.
The Question and Answer settings for that question display in the right pane of the window.

3 Under Question Settings, select Range.

4 In the box provided enter the Acceptable Value or set a Minimum or Maximum value for the range. Both
options may be used.

5 Click Save.

6 Click Done to save the changes.

To mark an answer correct for a Numeric Response question through the Settings Pane for a Numeric
Response question...

1 Place your cursor on the Numeric Response question for which you would like to assign values.
2 Select Correct from the Answer Value drop-down menu or enter a point value in the Settings Pane.
3 Click Set Range.

4 In the box provided enter the Acceptable Value or set a Minimum or Maximum value for the range. Both
options may be used.

5 Click Save.

Turning Technologies
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Identify Correct Answers for Matching Questions

Matching questions have two answer columns and as many answer rows as you have selected from 2 to 10.
To set correct answers for a Matching question for each of the answer rows, select which of the answers in
the second column corresponds to the answer in the first column.

To mark an answer correct for a Matching question through the settings window...
1 From the TestingPoint Ribbon, select Tools > Settings.
The Settings window opens.

2 In the left pane of the window, identify the Matching question for which you would like to set correct
answers.

3 Select the Answer for which you want to make a correct match.
The Answer Settings displays in the right hand window.

4 From the Correct Match drop-down menu, select the matching answer in the second column for the answer
in the first column you selected.

Choose from the values in the drop-down menu.
5 Repeat steps 3 and 4 for each remaining answer row in the question.

6 Click Done to save the changes.

To mark an answer correct for a Matching question through the Settings Pane...
1 Place your cursor on the Matching question for which you would like to set correct answers.
2 Click the Toggle Answer/Match button on the Settings Pane menu bar.

3 From the Answer Values drop-down menu select the matching answer that corresponds to the answer in
the first column

4 Repeat step 3 for each remaining answer option
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Set Point Values for Questions

You can enter the number of points that will be awarded (or subtracted) for each answer to a question.
TestingPoint accepts a range of point values from negative 10,000 to 10,000. The default point value for a
Correct answer is 1, while an Incorrect answer has a default point value of 0.

You can also assign different point values to different questions in a test (if one question is considered easier
or more difficult than another, for example).

To set a point value for a question...

1 From the TestingPoint Ribbon, select Tools > Settings.

The Settings window opens.

2 To assign the same point value to each question in the whole test:

a

In the left pane, select Test from the Settings hierarchy.
The available test settings display in the right pane of the window.
Under the Answer settings, select Correct Point Value.

A text box opens allowing you to enter a point value for correct answers. The point value can range from
negative 10,000 to 10,000.

Enter the Correct Point Value.
Click Apply to All.

TestingPoint sets the correct point value for the test.

To set incorrect point values for the entire test, go to step e. If you are done setting point values, go to
step 4.

Under the Answer settings, select Incorrect Point Value.

A text box opens allowing you to enter a point value for incorrect answers.
Enter the Incorrect Point Value.

Click Apply to All.

TestingPoint sets the incorrect point value for the presentation.

To set point values for a specific question go to step 3. If you are finished setting point values, go to step
4.

Click Done
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3 To assign individual point values to a specific question through the settings window:
a In the left pane of the window, select the question for which you would like to set a point value.
The available question settings display in the right pane of the window.
b Under the Question settings, select Correct Point Value.

A text box opens allowing you to enter a point value for correct answers. The point value can range from
negative 10,000 to 10,000.

¢ Enter the Correct Point Value.

The correct point value is set. To set incorrect point values, go to step d. If you are finished setting point
values, go to step 4.

d Under the Question Settings, select Incorrect Point Value.

A text box opens allowing you to enter a point value for incorrect answers. The point value can range
from negative 10,000 to 10,000.

e Enter the incorrect point value.

The incorrect point value is set.

Repeat step 3 for each question for which you want to assign individual point values. You can change
an answer’s point value by repeating these steps for the same question and entering a new point value.

f Click Done

4 To assign individual point values to a specific question through the Settings Pane:
a Place your cursor on the question for which you would like to set a point value
b Enter the correct point value in the box provided on the settings pane

c Enter the incorrect point value in the box provided on the settings pane
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Track Participants
and Teams

Participant Lists identify the members of your class who will use a response device to respond to test
guestions.

The participant name and other required information is stored along with the Device ID, a unique identifier for
a response device. The Device ID is printed on the device tag, which is located on the back of the device.

Participant List Wizard

Create a Participant List using the Participant List Wizard.

You may create multiple Participant Lists to be used with the same test. One Participant List contains
information about one audience group. Creating multiple Participant Lists allows you to capture responses
from multiple audiences.

Create a Participant List Using Participant List Wizard
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Create a Participant List Using Participant List Wizard

The Participant List Wizard guides you through the creation of a Participant List. The nhumber of responses
TestingPoint will accept is equal to the number of participants. You can control the number of responses to
your tests by selecting to enforce a Participant List.

You can choose from using standard list templates or create one of your own to store as much information
about your audience as you need.

To create a Participant List...
1 Click Participants on the TestingPoint Ribbon and select Participant List Wizard.

The TestingPoint Participant List Wizard window opens presenting the option to use a pre-defined Participant
List template or to create a custom template. Custom templates created in the past will appear in the My
Custom Templates region when the Custom Template button is selected.

2 Select a template to be used for the new Participant List.

Participant List template choices include:

Education—contains standard student information used for K—12 and higher education tests, such as
name and student ID.

Corporate—contains entries for the information most often used in corporate feedback meetings
including name, company name, telephone numbers, etc.

Available Fields—contains all information entries defined for use with TestingPoint.

Custom—allows you to create a personalized Participant List and to name the template or it allows you
to select a previously created template from the list.

3  Click Next.

If you opted to create a custom template, TestingPoint prompts you to name the template. Enter a name and
click OK.

TestingPoint displays the Participant List information entries (called fields). All entries that make up the
template appear in the Selected Fields region on the right. Use this page to add, delete, or reorder the entries
that make up the template.

4 You may choose to customize the list of Selected Fields.
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« Toremove an entry from the template, select it under the Selected Fields region and click the left arrow
button (<).

Note Alternatively, double click on an entry to
remove it from the Select Fields region.

* To add an entry to the template, select the desired entry from the Available Fields region, and click the
right arrow button (>).

Note Alternatively, double click on an entry to
add it to the Select Fields region.

» To change the order of the selected Fields click the up and down buttons.

* To add an entry to the template not listed under the Available Fields region, type the field name in the
Add a custom field box and click Add.

5 Click Next.

TestingPoint displays the Groups entry box. Use this screen to add Groups to your Participant List. Groups
provide categorization for greater reporting opportunities, such as demographic reports or team competitions.

6 You may choose to enter in a group name and click Add.

TestingPoint displays all groups in the Included Groups list. Repeat this step to add additional groups.
To remove a group, select it and click Remove.

a. Place checkmarks next to the groups to designate them as teams.
7 Click Next.

TestingPoint displays the Participant List summary page.
You have the option to revise your Participant List Settings.

The settings you can change include the Participant List file name, number of fields, and number of groups.
For file name select the old file name and enter a new one in the box provided. For Number of Fields or Number
of Groups, select the link to be returned to the screen and make edits.

8 Click Finish to create the Participant List.

TestingPoint displays the Participant Information window where you can enter, paste, edit or import data. You
can also Add/Remove or Rename Fields and Groups from this window. Find more information on editing a
Participant List in Modify a Participant List on page 35.
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If you made changes to an existing template, you are prompted to save the revised template.

If you select the Yes button to name and save the template, the custom template will be available under My
Custom Templates.

9 Add names and other participant information to the new Participant List or import participant information
from a .txt, .csv or Excel file:

a Click Import on the menu bar and select Excel/Delimited Text File.
b Browse to the location of the file and click Open.

The Delimited File Import window opens.
¢ In the Options section select one of the following:

Comma Delimited
Tab Delimited
Other - If selecting other, enter the delimited character in the box provided.

d Select the Text Qualifier if necessary.

e Select the Starting Row. If the .txt or .csv file contains a header row, it may be necessary to start with
the second row.

f Select the Starting Column.

7ip A preview of the selected file is displayed
in the bottom half of the Delimited File
Import window. If you are unsure of what to
set as the Starting Row/Column, refer to
the preview window for guidance.

g Click Import.
The file is imported and displayed in the Participant Information window.
h Optionally, edit student information as necessary.
10 Click Done or File > Save to save the data in the Participant List.

TestingPoint adds the new Participant List to TestingPoint Ribbon in the Select a Participant List drop-down
menu.

Next Steps
Find more information on editing and deleting your Participant Lists in Manage Participant Lists on page 35.

Turning Technologies
TestingPoint 1.2 34



Chapter 3: Track Participants and Teams

Manage Participant Lists

After you have imported a Participant List or created one with the Participant List Wizard, you can make
changes to a Participant List or delete it altogether.

This section describes how to:

Modify a Participant List
Verify Participants and Device IDs

Delete a Participant List

Modify a Participant List
Follow these steps to make changes to an existing Participant List.

Before You Begin
A Participant List has a .tpl extension (TestingPoint participants format). You must import the Participant List

or create a list using the Participant List Wizard before editing it with TestingPoint.

To modify a Participant List...
1 Click Participants on the TestingPoint Ribbon and select Edit a Participant List.
TestingPoint displays a window of Participant Lists saved in My Documents/TestingPoint/Participants.
2 Select the desired Participant List and click Open.
TestingPoint displays the Participant List data in the Participant Information window.
3 Edit the data by selecting the entries and typing new information.

4 You may choose to add a new patrticipant by right-clicking in the numbered column and selecting Add
Participant.

5 You may choose to remove a participant by right-clicking in the numbered box of that participant and
selecting Remove Participant(s).

6 Youmay choose to add a new column by right-clicking on an existing column and selecting Add Field/Group
> Add Field. The column will be added to the right of the existing column.

a Alternatively, select a column in the Participant Information window.
TestingPoint inserts the new field to the right of the selected column.
b Click Edit on the menu bar, mouse over Add Field/Group and select Add Field.
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An Add Participant Information window opens.
¢ Enter the name of the new field in space provided under Add a custom field.
d Click Add.
TestingPoint adds the newly created field to the Selected Fields list.
e Repeat steps d and e to add additional fields.
f  Click Finish.
TestingPoint adds the fields to your Participant List.

7 You may choose to add a group by right-clicking on an existing column and select Add Field/Group > Add
Group. The Group will be added to the right of the existing column.

TestingPoint automatically designates a group as a demographic.
a Alternatively, click Edit on the menu bar, mouse over Add Field/Group and select Add Group.
b Enter the name of the new group in space provided under Create a new group.
c Click Add.

TestingPoint adds the newly created group to the Included Groups list.

d Place checkmarks next to the groups to designate them as teams.
e Repeat steps d and e to add additional groups.
f  Click Finish.

8 You may choose to rename a Field/Group by right-clicking the Field/Group and selecting Rename
Field/Group.

a Alternatively, select the field or group that you want to rename.
b Click Edit on the menu bar and select Rename Field/Group.
A text entry window opens.
¢ Enter the new name of the Field/Group.
d Click OK.

TestingPoint renames the selected field or group.
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9 You may choose to remove a Field/Group by right-clicking on the Field/Group and selecting Remove
Field/Group.
a Alternatively, select the Field/Group that you want to remove.
b Click Edit on the menu bar and select Remove Field/Group.
TestingPoint deletes the selected field.
10 You may choose to Freeze a column by right-clicking on the column and selecting Freeze Column.
a Alternatively, select the column that you want to Freeze.
b Click Edit on the menu bar and select Freeze Column(s).

TurningPoint locks the column that you selected and limits your ability to rearrange the column order as
outlined in step 11. You will not be able to move any columns from the left of the frozen column to the
right of the frozen column in the Participant Information window. Conversely, you will not be able to move
any columns from the right of the frozen column to the left of the frozen column in the Participant
Information window.

11 You may choose to rearrange the column order in your Participant List.

a Place a checkmark in the box next to Check to rearrange column order located at the bottom of the
window.

TestingPoint limits the editing abilities while this function is active.
b Select the column you would like to be moved.
¢ Drag and drop the column in its new location.
12 Click File > Save.

A confirmation message displays.

a. Click OK.
13 Click Done.

The Participant Information window closes.
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Verify Participants and Device IDs
This section describes how to view the Participant List Display.

Before You Begin
You will need a participant list that contains the participant names and Device IDs. For instructions on how to

create a participant list see Create a Participant List Using Participant List Wizard on page 32.

1 Open the Test Administrator by selecting, Tools > Test Administrator. Select the Participant List and the
Test.

2 Click Participants on the TestingPoint Ribbon and select Participant List Display.

Delete a Participant List
This section describes how to remove a Participant List from TestingPoint.

Before You Begin
Deleting a Participant List sends the file to the computer’s Recycle Bin. Save a backup copy in another

location if you would like to be able to access the file later.

To delete a Participant List...

1 Click Participants on the TestingPoint Ribbon and select Delete a Participant List.
TestingPoint displays a window listing all Participant Lists that have been created or imported.

2 Select the file name of the Participant List you wish to remove.

3 Click Delete.
A window display confirming that you want to delete the selected Participant List.

4 Click Yes to delete the Participant List.

TestingPoint removes the file from the list.

7ip  To retrieve a Participant List after deleting it,
open the computer’s Recycle Bin, find the
file and select it. Either select to Restore
Item or drag and drop the file from the
Recycle Bin to a new location. If you choose
to drag and drop the file to a new location, It
will not be available to TestingPoint unless
you import the file.
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Set Up Team Competitions

TestingPoint can enhance group interaction. Team competitions are a fun way to encourage this interaction.
Set up team competitions through the Participant List Wizard. You can create a Participant List that enables
you to assign participants to teams who will compete for the highest score during your test.

You can also edit an existing Participant List and add Groups as teams using the Add Group feature, and
checking the appropriate checkboxes next to the Group names.

For participants or teams to accumulate scores, you will have to assign point values to correct answers.
This section describes how to:

Add Teams to a Participant List

Add Teams to a Participant List

You can create a Participant List that can enable team competitions by following the steps below. You can
also edit an existing Participant List and add Groups as teams using the Add Group feature, and checking the
appropriate checkboxes next to the Group names.

Before You Begin
These steps create a new Participant List that assigns participants to teams before the test, and allows you to

edit a existing Participant List to include Teams.

To set up team competitions...
1 Follow step 1 through step 5 in Create a Participant List Using Participant List Wizard on page 32.

In the Participant List Wizard window, TestingPoint displays the Groups entry box. Use this page to add groups
to your Participant List.

2 Enter a group name in the Create a new group field, and click Add. Repeat for all desired team names.

TestingPoint displays all groups in the Included Groups list. These groups can represent any type of grouping
you wish to assign participants to, such as teams, class level, or any other demographic information.

3 Choose the groups in the column to the right that you want to designate as teams competing by selecting
the appropriate checkboxes.

4 Click Next.

TestingPoint displays the Participant List summary screen.

5 Click Finish to create the Participant List and save it to a file.
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Real-Time Registration Tool

The Real-Time Registration Tool provides a fast, simple way to create a participant list for smaller audiences
(ideally less than 50 participants). Registration only takes a few moments, thus eliminating the need for a
permanent participant list. The steps below can be performed before each class to ensure each participant
has the appropriate response device.

How to Use the Real-Time Registration Tool

Before You Begin
You will need a participant list that has the participant names but does not contain Device IDs. For instructions

on how to create a participant list see Create a Participant List Using Participant List Wizard on page 32.

To verify Participants and Device IDs...

1 Open the Test Administrator by selecting, Tools > Test Administrator. Select the Participant List and the
Test.

2 Click Load Participant List.
3 Click Participants on the Test Administrator Ribbon and select Real-Time Registration Tool.

4 Click Registration Closed. The button label changes to “Registration Open” and the participants can begin
to register their devices.

5 Each participant will need to locate their name.
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6 Each participant must press the number on their response device that corresponds with the number to the
left of their name.

Real-Time Registration Tool with Responses

The Device ID for the participant will now appear in the Device ID column.

If more than 10 participants are in the Participant List, use the forward and back buttons to scroll page by page
to see the remaining participants. Clicking the play button will automatically scroll through the participants.

7 Once all of the participants have responded, click Registration Open.
8 Close the Real-Time Registration Tool by clicking the red (X) in the upper right-hand corner of the window.
9 Click Yes to save the participant list with the updated participant information.

The Real-Time Registration Tool window closes.
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Administering Tests

Prior to using TestingPoint to administering a test, you must have:

created a test;

imported an existing assessment into and modified it for use with the system;

created an answer key for an existing assessment.
After the test is created, you are now ready to administer it using TestingPoint. The tasks involved in
administering an test include:

distributing the test to the students;

identifying the amount of time the students have to take the test and enter their results in the response
device;

having the students transmit their responses;
saving the results for all students in a session file;

generating reports based on the results from the students.

About the Turning Test Administrator

The Test Administrator is the interface through which you receive test responses, save results and generate
reports. From the Test Administrator you can also create, load or edit answer keys and edit session
information such as question and answer text.
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Enter The Turning Test Administrator

The Turning Test Administrator can be accessed through the TestingPoint Ribbon or through the Windows
Start Menu.

How to enter the Turning Test Administrator...
1 Click Tools on the TestingPoint Ribbon and select Turning Test Administrator.

The Turning Test Administrator window opens and the Turning Test Administrator - Quick Launch window

opens.

2 Select Test or Answer Key by choosing the appropriate radio button and selecting the test or answer key
file from the drop down menu.

3 Select a Participant List from the select a participant list drop down menu.

4 Click Start.
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Turning Test Administrator Toolbar

The Turning Test Administrator Toolbar provides you with all of the options necessary for completing an
assessment. From this toolbar you can customize the look of the Test Administrator and create, load and edit
answer keys.

Turning Test Administrator Toolbar

Start/Stop Polling This button allows you to start or stop polling.

Test Management This button allows you to open a test or create, load or edit an answer key.

Test Management

Reset Session Resetting a session clears all received responses from the current test
session.
Continue Prior Session Allows you to open a test or answer key session again. This option is useful

for “make-up” tests if a participant was absent from the test session. The
transmitted responses will be appended to the test session.

Save Session This button saves your test session. Saving the session allows you to
generate reports at a later time.
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Tools This button provides you with options for generating reports. It also provides
access to the Test Administrator settings, the Session Viewer and LMS
Integrations.

Participants This button provides you with the options to create, edit, import or delete a

participant list. It also provides access to the Participant List Display and the
Real-Time Registration Tool.

Participant Drop-down From this drop-down you can select the participant list to be associated with
the test session.

Ao L

Polling Status Icon Indicates whether polling is open or closed.

Polling Stakus

Open
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Turning Test Administrator Window

The Turning Test Administrator consists of four main elements:

Turning Test Administrator Toolbar
Session Details Panel
Question Details Panel

Participant Details Panel

Turning Test Administrator Window
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Session Details
The Session Details Panel provides information about the current test or answer key, such as:

Test Name
Start Time

End Time
Remaining Time

Number of Responses

Question Details

The Results by Question Panel displays the test questions, average scores and possible points per question.
The average scores column adjusts as results are transmitted to the Test Administrator.

Participant Details
The Participant List Panel displays predetermined information from the selected participant list, such as:

Device ID
First Name
Last Name
User ID

Score
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Using an Answer Key with the Test Administrator

The answer key tool provides you with an alternative to creating a TestingPoint test if you have assessments
that were not created with the TestingPoint application.

Create an Answer Key
An answer key file can be created for a single test, or a test with multiple versions.

To create an answer key...
1 Open the Test Administrator and click Cancel on the Quick Launch Window.

2 Click Test Management on the Test Administrator Toolbar mouse over Answer Key and select Create Answer
Key.

3 Enter the Number of Answer Key Versions in the box provided.

4 Enter the Number of Questions in the box provided.

5 Enter the Default Correct Point Value in the box provided.

6 Enter a three-digit test Version Code for each test in the blue box to the right of Version Code.
7 Enter the correct answer for each question in the box provided.

The proper format is a “Capital Letter.”

Note The proper answer format for questions
with more than one answer must be in all
capital letters with NO spaces. For
example: ABCDF.

8 Once all of the correct answers have been entered for the test, click Save.

9 Name the answer key file and click Save.
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Load an Answer Key

To start a new test session by loading an answer key, follow the steps listed below.

1 Click Test Management on the Test Administrator Toolbar, mouse over Answer Key and select Load Answer
Key as Test.

2 Select the answer key file you wish to use and click Open

The Answer Key Details panel displays the key name, and the Overall Key Details panel adjusts to display the
answer key information.

Edit an Answer Key

To edit an answer key, follow the steps listed below.

1 Click Test Management on the Test Administrator Toolbar mouse over Answer Key and select Edit Answer

Key.
2 Select the answer key file you wish to edit and click Open

3 You are now able to edit the number of test version, test questions, correct answers and number of answers
for the test.
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Transmitting Results to the Test Administrator

In order for TestingPoint to grade your responses you must transmit the results to the Test Administrator. The
following sections outline how to do this with the ResponseCard XR.

Responding to Test Questions with the ResponseCard XR

Students can enter answers to questions in their ResponseCard XR response device. You enter the student
and response device ID in your Participant List. TestingPoint uses this information to create reports.

The ResponseCard XR features an LCD display as well as a keypad. The students use the keypad to control
the response device and enter their responses. The responses and all other messages are shown on the LCD

display.
To enter responses in the ResponseCard XR...
1 Press any button on the ResponseCard XR to turn on the device.
The Main Menu Displays.
2 Press the Yes/Down Arrow button until Test/Homework is selected.
3 Press the Enter button.
The Test/Homework screen displays, and the following options display:
4 Press the 1/A button to create a new test.
The Test Version screen displays.
5 Use the number pad on the ResponseCard to enter the three-digit Test Version number.
6 Once you have selected your test version number, press Enter on the ResponseCard XR.
A confirmation screen displays.
7 Select the Yes button if the information in the confirmation screen is correct.
The question screen displays.
8 Enter question responses using the ResponseCard XR.
The screen displays Storing... and the response is saved on the response device.
« Enter single digit numerical responses using the key pad.
1 displays at the top of the screen.
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* Press the Ans Mode button once to enter multi-digit responses.
123 displays at the top of the screen.
* Press the Ans Mode button twice to enter multi-digit alphabetical responses.
123 ABC displays at the top of the screen.
* Press the Ans Mode button three times to enter single digit alphabetic responses.

A displays at the top of the screen.

Transmitting Response Data with the ResponseCard XR

Once you have chosen answers to a test, you must transmit them to a Turning Receiver so that they can be
compiled and assessed.

How to Transmit Response Data...
1 Once all guestions have been answered, press the Menu button.
Three options displays on the screen.
2 You are prompted to Leave Test Mode. Press Yes.
3 Press the 1/A button to send test responses to the test administrator.
Test/Homework Send Successfully! displays.
4 Press the 2/B button to save test responses to the keypad.
Test Saved Successfully! displays.
5 Press the 3/C button to delete the responses that have been entered during the testing session.

A confirmation screen displays.
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TestingPoint Sessions

This section covers:

How to Save Session Files

How to Export Session Data as a CSV File

How to Save Session Files

TestingPoint displays the number of responses that have been received from the students. When all students
have transmitted their responses, you should save their responses to a session file. Session files are used to
generate reports showing how well the students performed on the assessment individually and as a whole.

To save session files...
1 Ensure all student responses have been accepted.

2 Click the Stop Polling Icon on the Test Administrator Toolbar to stop the test.
3 Click the Save Session Icon on the Test Administrator Toolbar.
A Save Session Dialog Box appears.

4 Choose a name and location for the session, then click Save.

The session is saved to the specified location.

How to Export Session Data as a CSV File

You can export data from a TurningPoint, TurningPoint Anywhere, or TestingPoint session file into a text file.
You can use the text file to import the data into a variety of other applications.

To Export Session Data as a CSV File...

1 Click Tools on the Test Administrator Toolbar and select Export CSV.
2 Select a session to export to CSV.

3 Choose the format to export the CSV data.

4 Click Export.

5 Specify a name and location for the exported file and click Save.
The file is saved, and the dialog box closes. A confirmation will be displayed that the data was exported
successfully.

6 Click OK to close the confirmation box.
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Configuring the Test Administrator

The Turning Test Administrator has many options that allow administrators to control how the ResponseCards
function, and how testing information is collected and managed. You can configure these options using the
Settings tool.

Open the Testing Administrator Settings

Before You Begin
Polling must be closed to access the Test Administrator Settings.

1 Click Tools on the Test Administrator Toolbar and select Settings.

Test Administrator Settings

The Settings tab displays a screen that allows you to configure several types of settings. The settings are
grouped by type and listed alphabetically. The name of each setting is in the left portion of the window and its
value is in the right. Some settings may allow you to enter a value, while others will offer a drop-down menu to
select from several choices.

The Common Settings and All Settings radio buttons allow you to select a level of detail for customization.
The Common Settings radio button displays the most commonly modified settings. The All Settings radio
button reveals additional settings for more in-depth customization.

The Defaults button allows you to return your settings to the default installation state.

The Settings tab allows you to configure the following settings:

Backup Settings
General Settings

Response Device Settings
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Description

Backup Maintenance

Backup Sessions

Setting

Allows you to specify the number of days the Backup Session files will
remain in the Backup folder before being automatically deleted.

Allows you to determine if TestingPoint will automatically backup
unsaved sessions files. If set to True, unsaved session files will be
automatically backed up and saved to the “Backup” folder within the
TestingPoint directory.

Description

Save Directory

Include test with session

Setting

Determines where the default save location for TestingPoint files.

Determines whether the test file is saved in the session file with the
response data.

Description

Force Channel Change

Enforce Participant List

Overwrite User Information

Empty (Receiver Number)

When set to True, allows you to retain the channel set in the
ResponseCard channel settings. If set to False, the channel will default
to the last used channel on the ResponseCard RF receiver.

When set to True, allows you to exclude the responses from
participants who are not in the selected Participant List. If set to False,
all participants’ responses will be accepted and appended to the end of
the list.

When set to True, allows User Information from a ResponseCard XR or
ResponseWare App to overwrite information in a loaded participant list.
If set to False, the User Information will be written only if that
information is currently blank.

Allows you to specify the radio frequency channel for ResponseCard
XR devices.

The main Polling Test tab region displays technical information, such as Device ID, channel number,
response data, and user information in the region at the bottom of the Polling Test tab. Select the Magnify
Response checkbox to view an enlarged version of user responses.
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Set Timing Options

The Timing Options allow you to determine an end time for the assessment. Through the Timing Options
window, you can opt to not have an end time or specify a length of time. Once the specified time has expired,
polling will automatically close.

To specify an end time...
1 Click Tools on the Test Administrator Toolbar and select Timing Options.

2 Choose atest length from the drop down menu. Test length options range from 15 minutes to 3 hours, with
15 minute increments.

3 Click Close.
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Reports

Reports allows you to generate and view a wide variety of reports based on the responses you received
during your TestingPoint session. The reports are generated as printable Word documents or Excel
worksheets with information about the questions and answers, participants, and responses gathered in your
test. Reports displays a hierarchical menu of reports organized by category, such as Results by Question
Reports and Demographic Reports. If you click on one of these categories, the Turning Reports screen
displays subheadings of specific report titles, and shows samples of each selected report.

Twenty-two reports are available for reporting on the entire audience, by individual participants, by standards,

and on the basis of demographics. If you have specified correct answers or point values, you can “grade”
participants and groups, verify that standards are met, and provide valuable feedback to participants.

View a Report

You can create reports using Reports available in the Tools menu in the TestingPointRibbon.
This section describes how to:

View a Report

View and Save a Report from an Answer Key Test
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View a Report
Use Reports to generate reports.

To view a report...
1 Click Tools on the TestingPoint Ribbon and select Reports.
The Turning Reports window opens, displaying two tabs: Sessions and Reports.
2 Select the Sessions tab.
The Turning Reports window displays a list of the session files in your Sessions folder.
3 Choose a session file.
You may choose a session file in one of the following ways:
+ Select the Current Session (in red text) to use the session currently open.
This option is available only if you have a TestingPoint test open and response data has been collected.
» Select a session file from the list of files in your Sessions folder.
To display the session files from your Sessions folder in the list of files, select My Session Files.
* Select a session file from your backup session files.
To display the backup session files in the list of files, select My Backup Session Files.
* Import a session file from another location.

You can also import a session using the Import Session button (shaped like a folder) above the list of
files. This allows you to use TestingPointsession files you have stored elsewhere.

4 Select the Reports tab once you have selected a session file.

The Turning Reports window displays a list of the categories of reports you can generate from your session file.

Each category of reports is listed by name. You can double-click the category or click on the plus sign beside
the category to view a list of reports in each category. The icon beside the report name indicates whether it
generates an Excel file or a Word file.

When you select a report, you can see a sample preview of the report on the right-hand side of the Turning
Reports window.

5 Select the type of report(s) you would like to generate by selecting the check box next to the report name.

Find more information in Types of Reports on page 60.
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You can select multiple reports by selecting multiple check boxes. You can also select an entire category of
reports by selecting the check box for the category.

You can change numeric responses to alphabetic responses by checking the Change numeric responses to
alphabetic responses check box.

6 Specify whether to include page breaks in the report by checking the Include Page Breaks check box (if
available).

If you check the box, TurningPoint will create page breaks at convenient places in the report for ease of printing.
7  Select the Generate Report button.

Turning Reports generates the report(s) and opens it in Microsoft Excel or Word, whichever is appropriate.

This may take some time, especially if you selected to generate a large number of reports or if there are a large
number of questions or participants in the session.

Note If you selected to generate multiple
reports, one Excel file is created with
worksheets for each report.

You can generate as many reports as you like. When one report is finished being created, select another type
of report from the list and select the Generate Report button again.

Note Alternatively, you can generate a report by
double clicking on the report name. Only
that report will be generated. Any other
reports that were selected will have to be
generated by double clicking each report
or selecting the Generate Report button to
generate them all.

8 When you are finished creating reports, select the Exit button to close the Turning Reports window.

Next Steps
You can use Excel or Word to edit, save, or print the reports.
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View and Save a Report from an Answer Key Test
Participant results are available in an HTML format for Answer Key tests.

Before You Begin
Response data from an answer key must have been submitted to the Turning Test Administrator.

1 Stop the test once all the participants have responded and click Save on the Test Administrator Toolbar.
2 Click Tools on the Test Administrator Toolbar and select Answer Key Results.
The participant name and score are displayed in an HTML format.
3 Click Save as CSV or Save as HTML.
4 Name the file and click Save.
» Click OK on the confirmation box.

5 Double-click the file to open it. The HTML file opens with a web browser and the CSV file opens with
Notepad.
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Types of Reports

This section describes:

Results by Question Reports (2 Reports)
Demographic Reports (2 Reports)
Participant Results Reports (4 Reports)
Results by Participant Reports (4 Reports)
Participant List Reports (2 Reports)
Standards Reports (2 Reports)
Comparative Scoring Reports (2 Reports)
Percentile Reports (2 Reports)
Other Reports (2 Reports)

Attendance Report

Response Data Export Report
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Results by Question Reports
The Graphical Results by Question and Results by Question Reports show a summary of responses for each
guestion. Each of these reports creates an Excel worksheet.

Graphical Results by Question Report
The report includes the following information for each question:
the answers
an indication of the correct answer(s)
the number of responses for each answer
the percentage of responses for each answer

pie chart with a percentage of the responses per answer

Results by Question Report
The report includes the following information for each question:
the answers
an indication of the correct answer(s)
the number of responses for each answer
the percentage of responses for each answer

the total count of participants that responded to the question
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Demographic Reports

The Demographic Comparison and Graphical Demographic Comparison Reports show a summary of
responses for each question broken down by demographics. Each of these reports creates an Excel
worksheet.

Demographic Comparison Report

The Demographic Comparison Report includes the following information for each question:
the answers
an indication of the correct answer(s)

the percentage of responses for each answer from each group

Graphical Demographic Comparison Report
The Graphical Demographic Comparison includes the following information for each question:
the answers
an indication of the correct answer(s)
the percentage of responses for each answer from each group
a vertical bar chart of the responses for each answer from each group

When generating the Graphical Comparison Report, you have the option of creating page breaks between
each question.
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Participant Results Reports

The Participant Results, Graded Participant Results (correct/incorrect), Graded Participant Results (point
values), and Graded Participant Results (ratio) Reports show a detailed question by question breakdown of
responses. When generating these reports you have the option of displaying the entire question or excluding
the question text. Each of these reports creates an Excel worksheet.

Participant Results Report

The report includes the following information for each participant:
Device ID
fields defined in the Participant List
the numerical value of the participant’s response to each question

Graded Participant Results (correct/incorrect) Report

The report includes the following information for each participant:
Device ID
fields defined in the Participant List
the numerical value of the participant’s response to each question
an indication of whether the response is correct or incorrect

total percent correct

Graded Participant Results (point values) Report

The report includes the following information for each participant:
Device ID
fields defined in the Participant List
the numerical value of the participant’s response to each question
an indication of whether the response is correct or incorrect

the total number of points

Graded Participant Results (ratio) Report
The report includes the following information for each participant:
Device ID
fields defined in the Participant List
the numerical value of the participant’s response to each question
an indication of whether the response is correct or incorrect
the ratio of correct answers to total number of answers for each question
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Results by Participant Reports

The Results by Participant, Results by Participant (Answer Detail), Response by Participant (Response
Detail), Results by Participant (Score Detail) show a detailed listing of responses for each question from each
individual participant. Each of these reports create an Excel worksheet.

When generating these reports, you have the option of creating page breaks between each participant’s
section.

Results by Participant Report
The report includes the following information for each participant for each question:

the question
the numerical value of the participant’s response
an indication of whether the response is correct or incorrect

the correct answer

Results by Participant (Answer Detail) Report

The Answer Detail Report includes a complete list of answers for each question. The list enables you to
match the numerical value of the participant’s response (number 1 or 2, etc.) to the actual answer (e.g. yes or
no) and highlights the correct answer in green. The report also shows whether responses are correct or
incorrect by marking them with a ‘c’ or an ‘i.’

Results by Participant (Response Detail) Report

The Response Detail Report includes the question along with the participant’s response. The report displays
correct answers in green, incorrect answers in red, the correct answer in brackets for incorrect answers, and
calculates the percentage of correct answers and the total points accumulated by each participant.

Results by Participant (Score Detail) Report
The Score Detail Report calculates the percentage of correct answers and total points accumulated by each
participant.
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Participant List Reports
The Participant List Reports show the participant data from the Participant List in either an Excel worksheet or

a Word document.

Note If you selected to generate the Word
document version of the Participant List
along with any other report, the Word
document is included as a worksheet in the
Excel file.

Participant List (Excel) Report
The report shows Device ID and any of the fields defined in the Participant List (name, contact information,

demographic groups or teams, etc.)

Participant List (Word) Report
The report shows Device ID and any of the fields defined in the Participant List (name, contact information,

demographic groups or teams, etc.)
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Standards Reports

The Group Standards, Individual, and Overall Standards Reports show response information based on
standards identified for each question. Each of these reports creates an Excel worksheet.

Group Standards Report
The Group Standards Report displays the percentage of correct responses from each group for each
standard.

Individual Standards Report
The Individual Standards Report includes the following information for each individual participant for each
standard:
the participant’s percentage of comprehension for all questions that are associated with the standard
the questions associated with the standard
the answers for each question
an indication of the correct answer(s)
an indication of the participant’s response and whether it was correct

When generating the Individual Standards Report, you have the option of creating page breaks between each
participant’s section.

Overall Standards Report
The Overall Standards Report is very similar to the Results by Question Report but includes additional
information relating to standards. It includes the following information for each standard:
the percentage of overall comprehension for all questions that are associated with the standard
the questions associated with the standard
the answers for each question
an indication of the correct answer(s)
the number of responses for each answer
the total count of participants that responded to the question

the percentage of responses for each answer
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Comparative Scoring Reports

The Individual Scoring and Scoring Distribution Reports show a summary of scoring information based on
participant responses in comparison to other participants. Each of these reports creates an Excel worksheet.

Individual Scoring Report

The Individual Scoring Report includes the following information for each participant:
numeric response labeled correct or incorrect
guestion’s overall percentage correct
participant’s percentage score

whether the participant’s score puts him/her above or below the class average

Scoring Distribution Report

The Scoring Distribution Report includes the following information:
the total number of participants
the score ratios for assessment (number of correct answers to questions)
the number of participants achieving each score ratio
the answer value (correct, incorrect, points, no value, keywords)
acceptable answer choices

number of responses each answer received
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Percentile Reports

The Percentile (correct/incorrect percentage) and Percentile (points) Reports show how participants’
responses. The reports include the Device ID, first and last name, and the percentile ranking for each
participant grouped by percentiles. You can change the percentiles shown by entering the new percentiles
separated by a semicolon in the appropriate box. Each of these reports creates an Excel worksheet.

Percentile (correct/incorrect percentage) Report
The Percentile (correct/incorrect percentage) Report includes the following additional information:

the total percentage of questions each participant answered correctly

Percentile (points) Report
The Percentile (points) Report includes the following additional information:

the total points accumulated by each participant
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Other Reports

The Other Reports option TestingPoint offers two uncategorized reports: Attendance, Comparative Links,
Response Data Export, Ranking Summary, and Statistics Reports. Each of these reports with the exception of
the Outline Report creates an Excel worksheet. The Outline Report creates a Word document.

Attendance Report
The Attendance Report provides basic participant information, including name and Device ID, and shows who

has attended the test.

Response Data Export Report
The Response Data Export Report gives the raw response data. It creates a table of values displaying the

numerical response values for each Device ID.
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Tools

TestingPoint offers several tools that allow you to use the powerful, advanced features:

Create and assign standards for evaluating participants
Create a test from a TurningPoint Session

Create a test from a QTI, Word, Excel or XML Document
Create a test from a Question Bank

Export a test or session into VantagePoint

Create a test aligned to state standards using QuestionPoint

Use the Integrations Tool to download participant lists and upload test results to Learning Management
Systems
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Standards

TestingPoint’s standards tools allow you to use built-in standards per state/country, type, subject and grade
level or create your own lists of standards on which participants can be evaluated. For training, teaching, or
testing, standards help you organize the material in your test into subject areas, competencies, or other
standards which the participants should meet. You can then view the participants’ results by standards using
Reports.

Before you can assign standards to test questions, you need to select from the Built-in Standards or create a
list of the standards you will be using.

This section describes how to:

Create a Built-in Standards List
Create a Custom Standards List

Assign Standards to Questions

Create a Built-in Standards List

TestingPoint comes with built-in standards per state, type, subject and grade level. You can create a list of
standards using any of these criteria.

To create a Built-in Standards List...
1 Click Tools on the TestingPoint Ribbon and select Standards.
2 Select the Built-in Standards Lists tab.
A window opens and displays four drop-down menus: state, type, subject, and grade level.
3 Select a state or country from the Select a state drop-down menu.
4 Select a type from the Select a type drop-down menu.
5 Select a subject from the Select a subject drop-down menu.
6 Select a grade level from the Select a grade level drop-down menu.

All of the Standards for the selected state, type, subject, and grade display in the left pane of the Standards
window.

7 Select a standard from the list.

8 Select the question to assign the standard to from the Current Selection drop-down menu.
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9 Select the right arrow button (>) to assign the standard to a question.

The standard displays in the list of standards in the right of the Standards window.

Remove a standard by selecting the standard on the right of the Standards window, then click the left arrow
button (<).

10 Repeat these steps beginning with step 7 to add standards to additional questions.

Assign multiple standards or use multiple Standards Lists.

If you would like to start over, you can select the Clear All button to clear all standards from all questions in the
test.

11  When you are finished assigning standards, click Done.

Create a Custom Standards List
TestingPoint allows you to create a list of standards to suit your specific needs.

To create a Custom Standards List...

1 Click Tools on the TestingPoint Ribbon and select Standards.

2 Select the Custom Standards Lists tab.
The Select a Custom List drop-down menu displays the current Standards list associated with the active test.
The drop-down menu allows you to choose from the Standards Lists in your Standards folder.

The Load button allows you to import a Standards List to your Standards folder from another location on the
computer or network.

The Delete button allows you to delete a Standards List from your Standards folder.

The New button allows you to create a custom Standards List.

3 Click New.

TestingPoint prompts you to enter a new name for the Standards List.

4 Enter a name in the box provided and click OK.

TestingPoint creates the Standards List in your Standards folder, displays it in the Custom Standards List drop-
down menu, and displays the new Standards List in the left-hand pane of the Standards window.

The new Standards List has a top-level category with the same name as the list.
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5 To add a Category or a Standard, complete the following steps.
a Click Add Category or Add Standard.
TestingPoint prompts you to enter a title for the Category or Standard.
b Enter a name in the box provided and click OK.
TestingPoint adds the Category or Standard to the Parent Category you selected.
¢ Repeat steps a and b to add additional Categories and/or Standards.

You can delete a category or standard from the list using the Remove button. You can change the name
of a category or standard using the Edit Field button.

6 When you are finished creating your Standards List, click Done.

TestingPoint indicates that you have made changes to the Standards List and asks if you would like to save
your changes.

7 Click Yes.
The changes are saved to your Standards List file and the Standards window closes.

Next Steps
To associate standards with questions, follow the instructions in the next section, Assign Standards to
Questions.

Assign Standards to Questions

Assigning standards to questions allows you to use Turning Reports to assess participant performance on
guestions relating to the standards.

Before You Begin
You should create or obtain a Standards Lists to be assigned to the questions. Find more information in
Create a Built-in Standards List on page 71 or Create a Custom Standards List on page 72.

To assign standards to questions...
1 Click Tools on the TestingPoint Ribbon and select Standards.

The Standards window opens displaying two tabs: Built-in Standards Lists and Custom Standards Lists.
2 Select either Built-in Standards Lists or Custom Standards List.

The remaining steps are the same for both applying a Built-in Standards or Custom Standards list.
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3 Select a Standards List in one of the following ways:
a Select a Standards List from the Standards folder using the Current Standards List drop-down menu.
The categories and standards are displayed in the left-hand pane of the Standards window.
b Select a Standards List from elsewhere using the Load button.

The Standards List file is copied to your Standards folder and the standards and categories are displayed
in the left-hand pane of the Standards window.

c Use the Built-in Standards List.
4 Choose a question from the Current Selection drop-down menu.
5 Select a standard from the list.
6 Select the right arrow button (>) to assign the standard to a question.

The standard is displayed in the list of standards in the right-hand pane of the Standards window.

Remove a standard by selecting the Standard on the right-hand side of the Standards Window, then click the
left arrow button (<).

You can also remove a Standard by highlighting it and pressing the delete key on the keyboard.
7 Repeat these steps beginning with step 4 to add standards to additional questions.

If you would like to start over, you can select the Clear All button to clear all standards from all slides in the test.

Note You can assign multiple Standards or use
multiple Standards List by starting with
step 3.

8 When you are finished assigning standards, click Done.

Next Steps
Several reports allow you to assess participant performance on the standards you assigned. Find more
information in Chapter 5: Reports.

Turning Technologies
TestingPoint 1.2 74



Chapter 6: Tools

Import Tests

This section describes how to:

Import Questions from TurningPoint
Import Questions from a Question Bank
Import Questions from QuestionPoint

Using these features of TestingPoint provides a quick way to create test questions from question and answer
data, found in other Turning files.

Import Questions from TurningPoint

TestingPoint retains the question settings used in the TurningPoint sessions such as answer value, point
value and if a question has been assigned as a demographic question.

To import questions from TurningPoint...
1 Click Tools on the TestingPoint Ribbon mouse over Import and select TurningPoint Session.
2 Navigate to the session you would like to import and select it.

3 Click Open to continue.

TestingPoint creates a test from the TurningPoint Session you imported.

Import Questions from a Question Bank

TestingPoint provides you with the ability to create a Question Bank and to then use that Question Bank to
insert single or multiple questions into a test.

Before You Begin
Prior to inserting questions from a Question Bank you must have a Question Bank already created. Find more

information in Creating a Test Document on page 19.

To insert a question from a Question Bank...
1 Click Tools on the TestingPoint Ribbon and select Insert from Question Bank.

2 Navigate to the Question Bank from which you would like to insert questions and select it.
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3 Click Open to continue.

The Import from a Question Bank Window opens.
4 Select the question or questions (by holding Ctrl on your keyboard).
5 Click Done.

TestingPoint creates the test.

Import Questions from QuestionPoint

QuestionPoint is a question bank of 30,000 high quality assessment items aligned to state standards, sorted
by grade and subiject.

Question Point has been integrated with the TurningTalk User Community. You can use the content found in
QuestionPoint to create an interactive presentation. For complete information on how to use QuestionPoint,
please refer to the QuestionPoint User Guide which can be downloaded from the Turning Technologies

website.

To generate a test using QuestionPoint...

1 Click Tools on the TestingPoint Ribbon mouse over Parser and select QuestionPoint.
2 Select the QuestionPoint content file (.tqz).

3 Click Open.

4 Click Yes to add the content to the current test, No to add content to a new test.

5 The QuestionPoint content is now included in the test.

Next Steps
Learn about how to export test information to VantagePoint to assess and compare test results in Using

VantagePoint with TestingPoint
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Parser Documents

The TestingPoint Parser can import four kinds of documents:

a QTI document

an XML document

a Microsoft Word document (.doc)

an Excel spreadsheet (.xIs)
To be imported by the TurningPoint Parser, these documents must be formatted in the proper way. The
following sections describe the proper formatting.

This section describes how to:

Format QTI Documents
Format XML Documents
Format Word Documents

Format Excel Documents
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Format QTI Documents
TestingPoint can convert your Respondus content into an interactive presentation through the QTI parser.
Acceptable question formats are:

Multiple Choice
Multiple Response
True/False
Fill-in-the-Blank

To format Respondus content for the TestingPoint QTI parser...

1 Open your Respondus software with a current personality of IMS QTI 1.1+,
2 Create or Edit your test.

3 Click the Preview & Publish Tab and select Save QTI XML File.

4 Select QTI XML zip file.

Click Save As.

&)

6 Name the file and click Save.
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Format XML Documents
The following is a basic shell of the XML document type accepted by the TurningPoint Parser:

<slides count="" id="">
<slide id="" type="" multiresponse=""">
<question alias="" filename="" imageposition="" />

<topic id=""">
</topic id>
<answers>
<answer alias="" value="" filename="" />
</answers>
</slide>
</slides>

Each element is described below, along with an example and an explanation of the attributes.

Note Remember that the following characters
are reserved in XML: <> & “ «

Use the XML entities for these characters
(&lt; &gt; &amp; &apos; &quot;
respectively).

slides
The slides element is the top-level element in the XML document and contains all the information

TurningPoint requires to create the interactive presentation. The slides element contains a number of slide
elements.

<slides count="1" i1d=""86FF9DB9”’>

</slides>

Attribute Description

count The total number of slide elements in the presentation.

id An optional attribute that contains a unique identifier for the group of slides.
slide

Each slide element contains the question and answer information for a single slide.
<slide i1d="E15F45B” type="D multiresponse=""1">

</slides>
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Attribute Description
id An optional attribute that contains a unique identifier for the slide.
type Defines what type of slide to create using a single-letter code. The following

types are accepted:

Q = standard question slide

P = picture slide

D = demographic slide

S = speed scoring slide

F =fill in the blank slide (ResponseCard IR, XL, and RF users are limited

to numerical responses, but ResponseCard XR and ResponseWare App
users may provide alphanumeric responses of varying lengths)

E = essay slide (ResponseCard IR, XL, and RF users are limited to
numerical responses, but ResponseCard XR and ResponseWare App
users may provide alphanumeric responses of varying lengths)

M = moment to moment slide

multiresponse An optional attribute that contains the number of responses allowed per
response device for the slide. Accepted values are 1-10.

The question element contains the question information (as attributes) and the question text (as content).

<question alias="Gender?” filename=
What is your gender?

imageposition=""">

</question>

Attribute Description

alias An optional attribute that contains an alias for the question.

filename An optional attribute that contains a filename for a picture that can be
included with the question.

imageposition An optional attribute that sets the question picture position. The following are

acceptable values:

L = Left
R = Right
F = Full
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topic
The topic element contains the question topic.

<topic id=""></topic>

Attribute Description
id An optional attribute that contains a unique identifier for the topic.
answers

The answers element contains a number of answer elements.

<answers></answers>

answer
Each answer element contains answer information (as attributes) and the answer text (as content) for a

single answer.

<answer alias="" value="" filename=""">
Female
</answer>
Attribute Description
alias An optional attribute that contains an alias for the question.
value An optional attribute that contains a value for the answer. Valid answer

values are “Correct”, “Incorrect”, or a point value from negative 10,000
through 10,000.

filename An optional attribute that contains a filename for a picture that can be used in
place of the answer text on the slide. This attribute is used only if the slide
type attribute is set to “P”.
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Format Word Documents

To create a Word document to be imported by the TurningPoint Parser, you must create an outline using the
heading styles built into Word. You can apply the heading styles by either using the drop-down menu in the
Formatting Ribbon, or in the Styles and Formatting pane available through the Format menu.

Each question must use the “Heading 1" style. The question is followed by several answers on separate lines
using the “Heading 2" style.

In addition to the question and answer text, you can use optional TurningPoint tags to control other settings.
Each TurningPoint tag must use the “Heading 3" style. Tags occur at the start of the outline (for tags that
apply to the entire presentation) or on the lines immediately following a question or answer (for tags that apply
only to a specific question or answer). A tag is formatted in the following way:

<tag>value
All tags are optional. If omitted, the slide will default to a standard question slide.

The tags are described in the following table.

Tag Location Description and Allowed Values

<c> Start of outline. The number of slides in the presentation.

<d> Start of outline or following a question. Contains the Session ID (if at the start of the outline) or
topic ID (if following a question).

<a> Following a question or an answer. Contains an alias for a question or an answer.

<t> Following a question. Defines what type of slide to create using a single-letter

code. The following types are accepted:

Q = standard question slide

P = picture slide

D = demographic slide

S = speed scoring slide

F =fill in the blank slide (ResponseCard IR, XL, and
RF users are limited to numerical responses, but
ResponseCard XR and ResponseWare App users
may provide alphanumeric responses of varying
lengths)

E = essay slide (ResponseCard IR, XL, and RF
users are limited to numerical responses, but
ResponseCard XR and ResponseWare App users
may provide alphanumeric responses of varying
lengths)

M = moment to moment slide

Turning Technologies
TestingPoint 1.2 82



Tag

Location

Chapter 6: Tools

Description and Allowed Values

<f>

<n>

<m>

<p>

<v>

Following a question or an answer.

Following a question.

Following a question.

Following a question.

Following an answer.
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The filename of a picture file. If the tag follows a
guestion, the picture will be added next to the question
text on the slide. If the slide type is “P” and the tag
follows an answer, the picture will replace the answer
text on the slide.

Contains the question picture position. The following
are acceptable values:

L = Left
R = Right
F = Full

Contains the number of responses allowed per
ResponseCard for the slide. Accepted values are 1-10.

Contains the question topic.

Contains a value for the answer. Valid answer values

are “Correct”, “Incorrect”, or a point value from negative
10,000 through 10,000.
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Format Excel Documents

You can format an Excel spreadsheet so that it can be used with the TurningPoint Parser. The TurningPoint
Parser will only use the data displayed in the first sheet of an Excel Workbook to create question slides.
Figure 3-1 displays a sample Excel spreadsheet that contains information to create four TurningPoint slides.

Figure 3-1

Figure 3-1 displays four questions and their corresponding answers. Column A contains Question Text,
columns B through K may contain Answer Text. All columns that follow after column K are ignored by the
TurningPoint Parser. The text does not have to be in a specific font. If you want to use Questions and
Answers only, there must be a blank line after each Answer row. If you wish to use tags, use one row for the
Question and Answer Text, one row for all of the tags (multiple tags are allowed per cell, see cell D3 in Figure
3-1), and one blank row below the tags.

Note Make sure to include only one blank row
between each tag row and the following
Question row. As soon as the TurningPoint
Parser detects two blank rows, it will stop
searching for text.

The spreadsheet also contains several TurningPoint tags that allow the TurningPoint Parser to process
additional information about the format of slides. A detailed listing of the TurningPoint tags and how they are
used in figure 3-1 is shown below in figure 3-2. This table explains how the tags are used in figure 3-1 to
format interactive slides. The tags are not case sensitive.

Figure 3-2
Tag Cell # Description and Allowed Values
<d> Al Session ID
A2, or any untagged row in Question Text

column A
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Tag Cell # Description and Allowed Values
<a> A6, or directly below any Question  Question Alias Text
Text
<t> A3 or directly below Question Text Defines what type of slide to create using a single-letter
code. The following types are accepted:
Q = standard question slide
P = picture slide
D = demographic slide
S = speed scoring slide
F = fill in the blank slide (ResponseCard IR, XL, and RF
users are limited to numerical responses, but
ResponseCard XR and ResponseWare App users may
provide alphanumeric responses of varying lengths)
E = essay slide (ResponseCard IR, XL, and RF users are
limited to numerical responses, but ResponseCard XR
and ResponseWare App users may provide alphanumeric
responses of varying lengths)
M = moment to moment slide
A2, B2, C2, or any cell directly to ~ Answer Text
the right of Question or Answer
Text
<f> B3, C3, D3, or directly below The filename of a picture file. If the tag follows a question,
Answer Text the picture will be added next to the question text on the
slide. If the slide type is “P” and the tag follows an answer,
the picture will replace the answer text on the slide.
<n> In the cell directly below the Contains the question picture position. The following are
Answer Text acceptable values:
L = Left
R = Right
F = Full
<m> In the cell directly below a Contains the number of responses allowed per
question ResponseCard for the slide. Accepted values are 1 to 10.
<p> In the cell directly below the Contains the question topic.
Question Text
<v> B6, C6, D6, or preceding any Contains a value for the answer. Valid answer values are c or

numerical Answer Text
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C for Correct, i or | for Incorrect, or a point value from
negative 10,000 through 10,000.
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Using VantagePoint with TestingPoint

VantagePoint is a data assessment management system that enables superintendents, curriculum directors,
principals, and teachers to view quarterly Adequate Yearly Progress (AYP) and performance reports in real-
time at the district, building and classroom level.

VantagePoint allows you to monitor and improve performance on state testing through aggregate tracking and
reporting to determine early intervention needs. VantagePoint provides TestingPoint a mechanism by which
you can evaluate your class progress by comparing your TestingPoint session against your state’s standards.

Upload a Test File to VantagePoint

You must upload your TestingPoint test file to VantagePoint before you can upload your session results. Once
the test file has been uploaded, it can be downloaded and used by any teacher in your district.

To upload a test file VantagePoint...
1 Click Tools on the TestingPoint Ribbon and select VantagePoint.

A window opens and displays text entry boxes for the VantagePoint login information (Server URL, User Name,
and Password).

Contact Turning Technologies Customer Support at 1-866-746-3015 to obtain login information.

2 From the VantagePoint window, enter the Server URL, User Name, Password.

Note After you have successfully logged into
VantagePoint once, your URL and
Username are saved.

3 Click Login.
A window opens and displays the Subject and Academic Term drop-down menus.
4 Select a subject from the Subject drop-down menu.
5 Select a term from the Academic Term drop-down menu.
6 Select a grade from the Grade drop-down menu.

7 Click Next.
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A window opens and provides you with three options: 1) Upload Test File, 2) Upload Session and 3) Download
Test.

8 Select Upload Test File.
9 Click Next.
10 Enter the Test Name in the box provided.

11 You can select to upload either the Current Test, which would be the open test document, or Browse to a test
in another location.

12 Click Upload.
You receive confirmation that the test has been uploaded successfully.
13 Click OK.

The message box disappears and the VantagePoint window closes.

Upload Session Results to VantagePoint

You can upload session results to VantagePoint in order to assess results and compare them with the results
of other testing sessions.

1 Click Tools on the TestingPoint Ribbon and select VantagePoint.

A window opens and displays text entry boxes for the VantagePoint login information (Server URL, User Name,
and Password).

Contact Turning Technologies Customer Support at 1-866-746-3015 to obtain login information.

2 From the VantagePoint window, enter the Server URL, User Name, Password.

Note After you have successfully logged into
VantagePoint once, your URL and
Username are saved.

3 Click Login.

A window opens and displays the Subject and Academic Term drop-down menus.

4 Select a subject from the Subject drop-down menu.
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Select a term from the Academic Term drop-down menu.
Select a grade from the Grade drop-down menu.
Select Next.

A window opens and provides you with three options: 1) Upload Test File, 2) Upload Session and 3) Download
Test.

Select Upload Session.
Click Next.
Choose the Assessment associated with the session results from the drop-down menu.
You can select to upload either the Current Session or Browse to a saved session in another location.
Click Upload.
You receive confirmation that the session results have been uploaded successfully.
Click OK.

The message box disappears and the VantagePoint window closes.

Download a Test from VantagePoint

Once a TestingPoint Test File has been uploaded to VantagePoint, it is available for download by any user
within that district.

Click Tools on the TestingPoint Ribbon and select VantagePoint.

A window opens and displays text entry boxes for the VantagePoint login information (Server URL, User Name,
and Password).

Contact Turning Technologies Customer Support at 1-866-746-3015 to obtain login information.

From the VantagePoint window, enter the Server URL, User Name, Password.

Note After you have successfully logged into
VantagePoint once, your URL and
Username are saved.
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3 Click Login.
A window opens and displays the Subject and Academic Term drop-down menus.
4 Select a from the Subject drop-down menu.
5 Select a term from the Academic Term drop-down menu.
Choose from Term 1 through 4.
6 Select a grade from the Grade drop-down menu.
Choose from Pre-K to Twelfth grade.
7 Click Next.

A window opens and provides you with three options: 1) Upload Test File, 2) Upload Session and 3) Download
Test.

8 Select Download Test.

9 Click Next.
10 Select the Test Name from the drop-down menu.
11 Click Download.

The VantagePoint window closes and the TestingPoint test opens.
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Settings

TestingPoint test settings provide you with a way to manage the settings for your test document.

Open TestingPoint Settings

1 Click the eyeglasses icon on the TestingPoint 2008 Settings Pane.

2 In the left-hand side of the window, click Test.

Test Settings

Test settings provide you with the following options:

Test Settings

Setting Description

Group Question Type Order This setting provides you with the ability to arrange the order of your
questions.

Different Versions of Test This setting determines the default number of different test versions

when you select Print Test from the TestingPoint Ribbon.

Multiple Choice Settings

Setting Description

Default Number of Answers This setting pre-sets the allotment of answer choices inserted with a
new question.

Default Number of Columns This setting pre-sets the number of columns inserted with a new
guestion.

Format to use Picture or Equation  This setting allows you, by default, to format your answer choices for
Choices pictures or equations.
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Description

Default Number of Answers
Default Number of Columns
Multiple Response Default

Format to use Picture or Equation
Choices

Setting

This setting pre-sets the allotment of answer choices inserted with a
new question.

This setting pre-set the number of columns inserted with a new
question.

This setting pre-sets the allotment of expected answer choices that a
participant may select with a new question.

This setting allows you, by default, to format your answer choices for
pictures or equations.

Description

Default Number of Answers

Format to use Picture or Equation
Choices

Setting

This setting pre-sets the allotment of answer choices inserted with a
new question.

This setting allows you, by default, to format your answer choices for
pictures or equations.

Description

Answer Bullet Format

Correct Point Value

Incorrect Point Value

Setting

This setting pre-sets the character type that represents your answer
options.

This setting pre-sets points associated with your correct answer.

This setting pre-sets points associated with your incorrect answer.

Description

Include Document

Turning Technologies
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This setting determines if the Word Document (.doc/.docx) is saved with
the Test File (.txlIt). It is recommended to set this to True to save extra
formatting of questions or objects outside of the TestingPoint tables. If
set to False, only TestingPoint questions and objects will appear the
next time you open the Test File (.txlt).
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Setting Description

Language This setting allows you to change TestingPoint to match the supported
language versions of Microsoft Windows and Microsoft Office
environments.

Show Startup Screen This setting determines if the startup screen is activated when
TestingPoint is launched.
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Integrations

TestingPoint integrates with several Learning Management Systems allowing you to:

Import Participant Lists

Export Grades/E-mail Student Grades

How to Login to a LMS

1 Open the Test Administrator.

2 Click Tools and select Integrations.

3 From the Management System drop-down menu select the LMS.
4 Enter the Server Address of the LMS and click Connect.

5 Select the Institution from the drop-down menu.

6 Enter the Username and Password and click Next.

7ip  Check the box next to Save this information
for future use to avoid entering the
information each time you open the
Integrations window.

How to Import a Participant List

Before You Begin
You must complete the steps in How to Login to a LMS on page 93.

1 Select Import Participant List and click Next.
2 Select the course you wish to import a participant list from and click Finish.
3 Save the patrticipant list.

4 You will receive confirmation that the list was successfully imported. Click OK.

Next Steps
For more information on participant lists see Chapter 3: Track Participants and Teams.
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How to Export Grades/E-mail Student Grades

Before You Begin
You must complete the steps in How to Login to a LMS on page 93.

1

2

3

Select Export Grades/E-mail Student Grades and click Next.
Select the course you wish to export to and click Next.

Choose the session file you want to upload grades from.

Check the box next to Add grades shown above to WebCT/BlackBoard gradebook and assign a column

header and maximum value.

* You may also check the box to e-mail individual results to students through WebCT/BlackBoard and
enter your e-mail address. You also have the option to Include Common Message.

Click Finish.
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